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Introduction - What is OSFrame?
OSFrame gives title bars and sizing borders fully configurable three-dimensional effects.    
Five levels of 3D effects are available for title bars and three levels are available for sizing 
borders.    A stripes effect can also be applied to title bars, and title bar text can be made to 
appear raised or inset.    Six levels of effects are available for dialog window borders.

OSFrame becomes an integral part of Windows after the resident portion (OSFRAMER.EXE) is 
loaded, and all windows in the system get the special treatment.

The OSFrame control panel is very similar to the Windows Control Panel color settings 
window.    After Makeover is installed, OSFrame should be used to control the colors used by 
Windows instead of the Control Panel color settings window.



OSFrame Keys
Use the following keys in OSFrame.

Key(s) Function
---------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------
Tab Moves forward through the buttons and fields on the OSFRAME main 

window.

Shift Tab Moves backward through the buttons and fields on the OSFRAME main 
window.

direction keys Moves cursor among colors in Basic and Custom Colors palette.

Spacebar Selects a color highlighted by the cursor in the Basic and Custom Colors 
palette.



OSFrame Commands
To get help with a particular command, choose the appropriate menu.

File Menu Commands
Import Scheme...
Export Scheme...
Exit

Options Menu Commands
Auto Preview
Maximum Compatibility
Auto-load OSFRAMER
Exit

Depth of effects Menu Commands
Application Control Menus
Document Control Menus
Titles
Borders
Active Title Bar Text
Active Title Bars
Active Borders
Inactive Title Bar Text
Inactive Title Bars
Inactive Borders
Dialog Boxes
Menu Bars

Utilities Menu Commands
Border Width
Control Panel...
Windows Setup...
Restart Windows
Exit Windows



File Menu Commands
The File menu commands allow you to export color schemes so that they can be transferred 
to other computers, and to import previously exported color schemes.    You can also close 
the OSFrame control panel.

Import Scheme...
Loads a color scheme from a previously exported color scheme file.    After the file name is 
specified, you can choose from the color schemes that are contained in the color scheme 
file.    You can also import color schemes from another OSFRAME.INI file.    Color scheme files 
have an OSF filename extension by default.

Export Scheme...
Saves a color scheme to a file that can later be imported by OSFrame, either on this 
computer system or another.    After the file name is specified, you will be prompted for 
name of the scheme as it will be saved in the file.    Multiple color schemes can be saved into
a file by exporting to the file multiple times.    This allows libraries of color schemes to be 
created.    Color scheme files have an OSF filename extension by default.

Exit
Terminates OSFRAME, but leaves OSFRAMER active.    If any scheme changes have not been 
saved, a prompt allows the exit to be canceled.



Options Menu Commands
The Option menu commands control miscellaneous OSFRAME and OSFRAMER options.

Auto Preview
Enables updating the system colors immediately when a color is changed or when an effect 
appearance is changed.    Even though the system colors are changed, they are not saved 
until the Save button is pressed.    The state of this option is saved from session to session.

Maximum Compatibility
Most Windows applications coexist with OSFrame peacefully.    If an application seems to 
have a conflict with OSFrame, turn this option on.    Enabling this feature disables colored 
inactive title bar text, title bar text effects, and title bar stripes.

Auto-load OSFRAMER
When enabled, Windows will automatically load OSFRAMER.EXE on startup so that the 
OSFrame effects become a part of Windows automatically.    See Installing OSFRAMER.EXE for
more details.

-----------------
Related Topics
Depth of effects Menu Commands
Changing a Color Scheme



Depth of effects Menu Commands
The Depth of effects menu commands control the effects that OSFrame adds to title bars 
and borders.    The first four commands enable certain effects, and the rest of the commands
use pop-up menus to control the available options.

Application Control Menus
Enables the 3-D effects for application control-menu boxes.    When this option is checked, all
of the application control-menu boxes will be shaded to match the minimize and maximize 
buttons.

Document Control Menus
Enables the 3-D effects for application control-menu boxes.    When this option is checked, all
of the document control-menu boxes will be shaded to match the minimize and maximize 
buttons.

Title Bars
Enables 3-D effects or special effects for all title bars.    The Depth menu commands are used
to control the effect applied to the title bars.

Borders
Enables 3-D effects for all sizing borders.    The Depth menu commands are used to control 
the effect applied to the borders.

Active Title Bar Text
Controls the appearance of the effect applied to active window title bar text.

Active Title Bars
Controls the appearance of the effect applied to active window title bars.

Active Borders
Controls the appearance of the effect applied to active window sizing borders.

Inactive Title Bar Text
Controls the appearance of the effect applied to inactive window title bar text.

Inactive Title Bars
Controls the appearance of the effect applied to inactive window title bars.

Inactive Borders
Controls the appearance of the effect applied to inactive window sizing borders.

Dialog Boxes
Controls the appearance of the effect applied to dialog box borders.

Menu Bars
Controls the appearance of the effect applied to menu bars.

-----------------
Related Topics
Options Menu Commands
Changing a Color Scheme





Active Title Bar Text / Inactive Title Bar Text
These commands control the appearance of the effects applied to title bar text in the 
respective types of windows.    There are two types of effects that can be applied to the title 
bar text.    Both effects use a second color that can make the text appear raised or inset.    
Clicking on the title bar text in the sample window, when title bar text is already selected, 
will select the secondary text screen element.

None
Title bar text will be unaffected and will appear as it does without OSFrame..

Shadow
Places the secondary text color to the right and bottom of the normal text.    Use a light 
primary text color and a dark secondary color to make the text appear raised.    Use a dark 
primary color and a light secondary color to make the text appear inset.

Edge
Places the secondary text color to the left and top of the normal text.    Use a dark primary 
color and a light secondary color to make the text appear raised.    Use a light primary text 
color and a dark secondary color to make the text appear inset, but be aware that this 
combination does not seem to yield good results.

-----------------
Related Topics
Depth of effects Menu Commands
Changing a Color Scheme



Active Title Bars / Inactive Title Bars
These commands control the appearance of the effects applied to title bars in the respective
types of windows.    There are five types of effects that can be applied to the title bars. Most 
of the effects add a user controlled color along the top and left sides of a title referred to as 
the edge, and a user controlled color along the bottom and right sides referred to as the 
shadow.    The thickness of the edge and shadow can make a big difference in the amount of 
perceived 3-D effect.

Light
Adds a narrow edge and a narrow shadow.

Medium
Adds a narrow edge and a thick shadow.

Heavy
Adds a thick edge and a thick shadow.

Stripes
Adds horizontal stripes to a title bar.    The stripes use the same color as the title text.    This 
option does not add edges or shadows to the title bar.

Light/Stripes
This is a combination of the Light option and the Stripes option.    It adds horizontal stripes, a
narrow edge, and a narrow shadow to the title bar.

Heavy/Stripes
This is a combination of the Heavy option and the Stripes option.    It adds horizontal stripes, 
a thick edge, and a thick shadow to the title bar.

-----------------
Related Topics
Depth of effects Menu Commands
Changing a Color Scheme



Active Borders / Inactive Borders
These commands control the appearance of the effects applied to sizing borders in the 
respective types of windows.    There are three types of effects that can be applied to the 
borders.

Light
Adds an edge on the left and top sides of borders.    The shadow and edge colors are used for
the marks that show where the border corners are.    This option requires that the border 
width be set for at least 3, otherwise the border will not be affected.

Medium
Adds an edge on the left and top sides of borders.    The shadow color is used on the right 
and bottom sides of borders on the right and bottom sides of windows.    The shadow and 
edge colors are used for the marks that show where the border corners are.    This option 
requires that the border width be set for at least 4 to get the full effect.

Heavy
Adds an edge on the left and top sides of borders.    The shadow color is used on the right 
and bottom sides of borders.    The shadow and edge colors are used for the marks that show
where the border corners are.    This option requires that the border width be set for at least 
4 to get the full effect.    This option can yield a very obvious 3-D effect with proper color 
selection

-----------------
Related Topics
Depth of effects Menu Commands
Changing a Color Scheme



Dialog Boxes
These commands control the appearance of the effects applied to dialog window borders.    
There are six types of effects that can be applied to the borders of dialog windows with title 
bars.    The effects applied to the title bars are controlled by the normal window title bar 
controls.    All six effects also turn on a single type of effect for dialog windows without title 
bars.

None
All dialog windows appear as they would without OSFrame.

Light
Adds an edge and a shadow to the outside of the dialog frame.    This makes the whole 
dialog appear raised on the screen.

Medium 1
Adds an edge and a shadow to the outside of the dialog frame, and adds a border using the 
frame color on the inside of the dialog frame.

Medium 2
Adds an edge to the outside of the top and left sides of the dialog frame, adds an edge on 
the inside of the bottom and right side of the dialog frame, and adds a border using the 
frame color on the inside of the dialog frame.

Heavy 1
Adds an edge and a shadow to the outside of the dialog frame, adds a border using the 
frame color on the inside of the dialog frame, and adds an edge on the inside of the bottom 
and right side of the dialog frame.

Heavy 2
Adds edges and shadows all the way around the dialog frame, and adds an edge on the 
inside of the bottom and right side of the dialog frame.    This creates a prominant 3D effect.

Heavy 3
Like Heavy 2, but tries to fix an alignment problem with the control menu box.    Try Heavy 1 
and 2 to see which way looks best to you.

-----------------
Related Topics
Depth of effects Menu Commands
Changing a Color Scheme



Menu Bars
These commands control the appearance of the 3D effects applied to menu bars.    When a 
menu bar occupies only one line, all three effect levels have the same appearance, but they 
appear differently when a menu bar occupies more than one line.    Pull down and popup 
menus will not be changed in appearance.

None
Menu bars will be unaffected and will appear as they do without OSFrame.

Light
Adds a thin edge on the top and left sides of the menu bar, and a thin shadow to the bottom 
and right sides of the menu bar.    No additional effects are applied when the menu bar 
occupies more than one line.

Medium
Adds a thin edge on the top and left sides of the menu bar, and a thin shadow to the bottom 
and right sides of the menu bar.    A dividing line will be placed on a multi-line menu bars 
using the menu bar shadow and edge colors.

Heavy
Adds a thin edge on the top and left sides of the menu bar, and a thin shadow to the bottom 
and right sides of the menu bar.    A dividing line will be placed on a multi-line menu bars 
using the menu bar shadow color, the window frame color, and the menu bar edge color.

-----------------
Related Topics
Depth of effects Menu Commands
Changing a Color Scheme



Utilities Menu Commands
The Utilities menu provides quick access to global Windows parameters and actions.

Border Width
This command is only available with Windows 3.1 or higher.    It allows you to change the 
width of sizing borders without opening the Windows Control Panel.

Control Panel...
Opens the Windows Control Panel program, which is used to control various system 
components such as fonts, printers, and desktop parameters.    The Desktop icon opens a 
dialog which allows you to change wallpaper, background patterns, and sizing border width.  
Sizing border width can be very important to the appearance of an OSFrame color scheme.

Windows Setup...
Opens the Windows Setup program, which is used to change display, keyboard, mouse, and 
network drivers.

Restart Windows
Is equivalent to exiting Windows and then restarting it.    This is useful if you have modified a
system component or setting that requires Windows to be shutdown and restarted.    It is 
also useful if an errant program has improperly used up system resources, or caused a UAE 
and you're concerned about system integrity.

Exit Windows
Leaves Windows and returns you to a DOS prompt.



Pushbuttons and Editing Tools
The OSFrame main screen contains push buttons and editing tools for performing most of 
the color scheme editing operations.    These buttons and editing tools are described in the 
following topics.

Color Scheme List
Add Scheme
Remove Scheme
Sample Window
Preview
Save
Restore
Screen Element
Basic Colors
Custom Colors
Define Custom Colors



Color Scheme List
This drop-down list box lists the currently defined color schemes.    The first item in the list is 
the scheme that the driver defines as its default.    OSFrame schemes follow, and schemes 
defined in the Control Panel follow the OSFrame schemes.    The Control Panel schemes have 
a prefix of <cp>.    This allows you to import Control Panel created schemes into OSFrame for
further enhancement.

Please keep in mind that the border depth settings require borders to be at least 4 or 5 units 
for OSFrame to be able to affect the border appearance.    You may need to change your 
border widths to get the full effect of a color scheme.

-----------------
Related Topics
Add Scheme Pushbutton
Remove Scheme Pushbutton
Pushbuttons and Editing Tools



Add Scheme
This push button adds the currently defined scheme to the Color Scheme List.    If a scheme 
by the same name already exists, it will be replaced with the currently defined scheme.    All 
of the aspects of a color scheme are saved, including all settings and depth controls.

When the button is pushed, you will be presented with a dialog box asking for the new 
scheme name.    If the current scheme already had a name, it will appear in the name edit 
box.    Enter the new scheme name and press OK to add the scheme to the list.    You can 
abort the operation by pressing Cancel.

After adding a scheme to the list, you will be asked if you want to save it as your permanent 
color scheme.    See the Save Pushbutton topic for more information.

-----------------
Related Topics
Color Scheme List
Remove Scheme Pushbutton
Pushbuttons and Editing Tools



Remove Scheme
This push button removes the currently selected scheme from the Color Scheme List.    You 
will get a dialog box asking for approval to remove the scheme.    Press Cancel to abort the 
scheme removal.    Pressing OK will delete the scheme from the list and select the next 
scheme in the list.

-----------------
Related Topics
Color Scheme List
Add Scheme Pushbutton
Pushbuttons and Editing Tools



Sample Window
The Sample window shows you approximately what a color scheme will look like.    You can 
select a screen element to have its color changed by simply clicking in the sample window 
with the mouse.    You may find it easier to select certain elements by using the Screen 
Element drop-down list box.    Use the Preview pushbutton to update the system colors to 
those shown in the sample window for a quick look at the new color scheme.

-----------------
Related Topics
Preview Pushbutton
Screen Element
Pushbuttons and Editing Tools



Preview
This push button updates the system colors to match the currently defined scheme.    This 
feature allows you to quickly try out a color scheme before saving it as your permanent color
scheme.    Sometimes a color scheme looks a lot different against wallpaper.

When the Settings, Auto Preview menu option is checked, the Preview button will be grayed 
and cannot be pushed.

-----------------
Related Topics
Save Pushbutton
Restore Pushbutton
Pushbuttons and Editing Tools



Save
This push button makes the currently defined scheme the scheme that will be used when 
Windows is started.    You will be presented with dialog box asking if you want to make the 
current scheme the permanent color scheme.    It is permanent in the sense that it will be the
scheme in use until you select a new scheme, or modify it.

This command updates several files and quite a few parameters.    It can take up to a minute
to complete, so be patient.

-----------------
Related Topics
Preview Pushbutton
Restore Pushbutton
Pushbuttons and Editing Tools



Restore
This push button returns the system colors to the scheme that was in use when the OSFrame
configuration program was started.    This allows you to preview a color scheme, and then 
return to your original colors if desired.

-----------------
Related Topics
Preview Pushbutton
Save Pushbutton
Pushbuttons and Editing Tools



Screen Element
This drop-down list box lets you select the screen element whose color is to be changed.    
You can also select screen elements using the Sample window.

-----------------
Related Topics
Sample Window
Basic Colors
Custom Colors
Pushbuttons and Editing Tools



Basic Colors
Selecting a color from this color palette will change the color of the currently selected screen
element.    Click on a color to select it, or use the arrow keys and press <space> to select the
color.

These are the colors that the display driver provides.    The developers of the display driver 
have determined that these colors can be displayed with reasonable quality by your video 
card.

-----------------
Related Topics
Screen Element
Custom Colors
Pushbuttons and Editing Tools



Custom Colors
Selecting a color from this color palette will change the color of the currently selected screen
element.    Click on a color to select it, or use the arrow keys and press <space> to select the
color.

You can change the colors contained in this palette by using the Control Panel Color window 
Define Custom Colors... push button.

-----------------
Related Topics
Screen Element
Basic Colors
Define Custom Colors Pushbutton
Pushbuttons and Editing Tools



Define Custom Colors
This push button presents a dialog box that allows you to create a custom color, or update 
the colors in the Custom Color palette.

-----------------
Related Topics
Custom Colors
Pushbuttons and Editing Tools



OSFrame Procedures
The Procedure topics give you step-by-step instructions for using OSFrame.

For information on how to use Help, press F1 or choose Using Help from the Help menu.

Getting Started
Installation

Customizing Color Schemes
Changing a Color Scheme
Saving a Color Scheme
Selecting Existing Color Schemes
Removing Existing Color Schemes



Installation
If you are installing from the OSFrame diskette:

1. Start Windows as you normally do.
2. Insert the OSFrame diskette into your floppy drive.
3. From the Program Manager File menu, choose Run.
4. In the Command Line box, type a:osfsetup

(or [drive letter]:osfsetup)
5. Press the Enter key.
6. Follow the instructions displayed on your screen.

The files OSFRAME.EXE, OSFRAME.HLP, OSFRAME.INI, and OSFRAMER.EXE on the distribution
diskette(s) are copied into your Windows directory:

OSFRAME.EXE is the configuration program for OSFrame.    It becomes your Windows 
appearance control center.    After OSFRAME is installed, you should use it anytime color 
settings are changed.    Using the Control Panel will not update all of the information that 
OSFrame uses, and may result in unexpected color schemes.

OSFRAME.INI is where all of the OSFrame configuration information is stored.    It should not 
be edited directly.

OSFRAME.HLP is this help file.

OSFRAMER.EXE is the portion of OSFrame that actually does the work.    It appears under two
names on the distribution disk.    OSF300.EXE is the Windows 3.0 compatible version, and 
OSF310.EXE is the Windows 3.1 compatible version.    The setup program will automatically 
copy and rename the appropriate version.

The Setup program does the tasks described in the Installing OSFRAME.EXE and Installing 
OSFRAMER.EXE topics.    They are here for those of you who really want to know exactly what
is going on.

-----------------
Related Topics
Installing OSFRAMER.EXE
Installing OSFRAME.EXE



Installing OSFRAMER.EXE
OSFRAMER.EXE is the portion of OSFrame that actually does the work.    It appears under two
names on the distribution disk.    OSF300.EXE is the Windows 3.0 compatible version, and 
OSF310.EXE is the Windows 3.1 compatible version.    The setup program will automatically 
copy and rename the appropriate version.    OSFRAMER.EXE must reside in your WINDOWS 
directory.

Please note that OSFRAMER does not show up as an icon while it is running.

Select the Auto-load OSFRAMER command on the Options menu to automatically perform 
the process described below.

The WIN.INI file provides a way for programs to be loaded as icons or run automatically 
when Windows is started (Your Windows documentation describes the WIN.INI file and how 
to edit it.).    Edit the load= statement in the [windows] section of your WIN.INI file to include
OSFRAMER as the first program.    The line will read load=osframer if no other programs 
are being started as icons.    After editing the load= line, Windows must be exited, then 
restarted for the load= changes to take effect.

Selecting the Auto-load OSFRAMER command when it is already checked will remove 
OSFRAMER from the load= statement.

OSFRAMER can alternately be set up as an Program Manager icon so that you can easily 
start it when the 3-D effects are desired.    You can also load OSFRAMER using the File,Run... 
command.

If you are running Windows 3.1, you can setup OSFRAMER.EXE as an item in the Startup 
group.

If you are running Norton Desktop for Windows, you can place the item in the AutoStart 
group.    This seems to prevent excessive redrawing of the desktop during startup.

-----------------
Related Topics
Installation
Installing OSFRAME.EXE



Installing OSFRAME.EXE
OSFRAME.EXE is the configuration program for OSFrame.    It becomes your Windows 
appearance control center.    After OSFRAME is installed, you should use it anytime color 
settings are changed.    Using the Control Panel will not update all of the information that 
OSFrame uses, and may result in unexpected color schemes.

Use the Program Manager's New... command to add OSFRAME as an icon in a group window. 
After the OSFrame icon is set up in a Program Manager group, it can then be selected to 
change colors or effects.

OSFRAME can also be run from any program that allows a program to be executed.

-----------------
Related Topics
Installation
Installing OSFRAMER.EXE



Changing a Color Scheme
A color scheme can easily be customized to better suit you.    Click on the screen element 
you wish to change in the sample window or choose the screen element from the Screen 
Element drop-down list box.    Then select a new color for it from the Basic Colors palette or 
Custom Colors palette.    The sample window will show the result of the color change.

If Auto Preview is enabled, the system colors will also be changed immediately., otherwise 
you can press the Preview button to update the system colors.

After you have created a custom scheme that you like, you should save it in the Color 
Schemes list using the Add Scheme button.    You should then make it your active color 
scheme by pressing the Save button.

Press the Restore button if you wish to restore the colors you started with.

-----------------
Related Topics
Options Menu Commands
Depth of effects Menu Commands
Saving a Color Scheme
Selecting Existing Color Schemes
Removing Existing Color Schemes



Saving a Color Scheme
A custom color scheme can be saved by pressing the Add Scheme button.    A dialog box will 
appear that allows you to name the scheme with up to 32 characters.    After entering the 
name, press the OK button and the scheme will be entered into the Color Schemes list.    
Press the Cancel button to abort the save.

-----------------
Related Topics
Changing a Color Scheme
Selecting Existing Color Schemes
Removing Existing Color Schemes



Selecting Existing Color Schemes
To select a color scheme, select one of the color schemes from the Color Schemes drop-
down list box.    To see what the color scheme looks like, press the Preview button, and the 
colors will be shown using any open windows.    If you like the color scheme, push the Save 
button and the color scheme will become your active color scheme.    If you want to restore 
the previous colors, push the Restore button.

Changing a color scheme allows you to customize an existing color scheme to suit your 
taste.

Any schemes that were created using the Control Panel will have a <cp> in front of them.    
This allows you to import schemes created using the Control Panel.

-----------------
Related Topics
Changing a Color Scheme
Saving a Color Scheme
Removing Existing Color Schemes



Removing Existing Color Schemes
Color Schemes created using OSFRAME or the Control Panel can be deleted.    Any schemes 
that were created using the Control Panel will have a <cp> in front of them.

To remove a color scheme, select the color schemes from the Color Schemes drop-down list 
box.    Choose Yes to confirm the deletion, or No to cancel.

The Windows Default scheme cannot be deleted.

-----------------
Related Topics
Changing a Color Scheme
Saving a Color Scheme
Selecting Existing Color Schemes



Terms



Drop-down list box
A single line list box that opens to display a list of choices.    Use the up or down arrows to 
make a selection, or press the down arrow with the mouse and click on an item in the list.



Edge
The brighter color on the top and left sides of a raised object that occurs when light is 
striking the object from the top left.



Sample Window
The area of the OSFRAME program that shows how Windows will look with a color scheme.    
It is also used to select a screen element for a color change.    Position the mouse over the 
area to be changed and click.



Shadow
The darker color on the right and bottom sides of a raised object that occurs when light is 
striking the object from the top left.





OSFrame License Agreement Information
Copyright © 1990-1992 Playroom Software.    All Rights Reserved.

OSFrame is a component of the Makeover for Windows utility program package.

The use of OSFrame is covered by the Makeover license agreement.    OSFrame is 
copyrighted property belonging to Playroom Software, and may only be used per the terms 
of the license agreement.    Any other use is a violation of United States Federal Copyright 
laws.

Should you have any questions concerning the agreement, or if you wish to contact 
Playroom for any reason, please write Playroom Software / 7308-C East Independence Blvd. /
Suite 310 / Charlotte, NC    28227 / (704)-536-3093.


